
Mastering a CD in Peak 4

“Mastering” is the final stage of arranging and polishing
material prior to sending it out for mass duplication.
This process typically consists of editing songs, using
effects processing to emphasize particular instruments
or voices, adjusting levels to suit each song, arranging
songs in a particular order, inserting just the right
amount of silence between songs, and converting the
format from a high-definition digital audio file to a stan-
dard CD audio format that can be played in any CD play-
er, and of course, burning the final “master” copy.

In the mastering process, Peak picks up where a multi-
track DAW leaves off – after songs have been recorded
and mixed as desired – stereo (and sometimes mono)
masters are the end result.  Peak’s job is to take all these
individual files, and assemble them in such a way that the
order of songs makes sense according to the artist’s
intent and vision.  That is, depending on the style of
music, certain elements of the mix may need to be
enhanced.  For example, if you’re mastering a CD of
dance music, you’ll most likely want to add equalization
in the low end of the frequency spectrum, so the drums
and bass really stand out.  On the other hand, if you’re
mastering classical music, you would not want to use the
same type of equalization setting, as there are far more
instruments in the mix, and you may want to really
emphasize a softer, gentler sound, such as a violin or a
flute.

To master a CD in Peak, you will need a few songs that
have been mixed down from your DAW application, as
well as a blank CD-R disc.  To easily access Peak, you may
also want to create an alias in the Dock by clicking on the
Peak application icon and dragging it into the Dock.  The
next few examples show how to accomplish common
tasks in mastering – such as trimming the beginnings

and ends of songs, applying fade-ins & fade-outs, normal-
izing levels, and applying touch up effects such as EQ or
compression.

Trimming Songs:

1.  Open your song files (or a folder full of files) in
Peak by selecting them in the Finder, and dragging
and dropping them over the Peak application icon
in the Dock.

2. Once open in Peak, an easy way to view all the files
is to tile all the audio document windows – by
choosing Tile Windows from the Window menu
(-T).  Now it’s easy to find the file you wish to
begin working on. To get a better view, click the
green maximize button in the upper left corner of
the audio document’s window. 

3. The song we’ll start off with is well mixed, and has
nice strong levels right out of the DAW, but needs
a bit of trimming at the beginning and end, as there
are several seconds of silence at either end that we
don’t really want on the finished CD.  The best way
to eliminate this silence, without actually cutting
out any material, is to create a “region” around the
area of the song that we want to keep – anything
that falls outside of the region’s markers will not
translate into the next stage, which is assembling
the Playlist.  To locate the exact spots for the begin-
ning and end of the region, play the file from the
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beginning, and when you reach the spot where the
song should start, stop playback, and insert a new
reference marker by choosing New Marker from
the Action menu (-M), or by clicking the
Toolbar’s New Marker button.

4. Now, also place a reference marker before the end
of the file, as there are several seconds of unwant-
ed silence here as well.  To locate quickly to the
end of the file without having to hear the entire
song, click into Peak’s file overview, near the end of

the file – playback will start at whatever point you
click.  As the playhead reaches the end of the song,
try to drop a reference marker in place while audio
is playing, using the keyboard shortcut -M.  If the
marker doesn’t get put in exactly the right place, it
can be moved into position later by clicking and
dragging the triangular base of the marker to the
left or right.

5. With markers in place, designating where the actu-
al beginning and end of the song should be, it’s

BIAS Tutorial2

Multiple audio documents tiled neatly on the screen

Marker placed where song *should* start

Marker placed where song *should* end



time to create a region around this part of the
song.  Regions are always created around a selec-
tion in the audio waveform – that is, you must first
select an area, and when you choose New Region
from the Action menu, markers are placed at the
beginning and end of the selection automatically.
There are various ways to make selections, but
since we’ve already placed reference markers
where we want the song to start and end, it’s easi-
est to -click between the two markers, and Peak
automatically selects the space between them.
This holds true for any two markers of any kind
(reference, region, or loop) – if you -click
between them, you’ll select the entire area.  Since
we’re already located at the end of the song, the
easiest thing to do is simply -click to the left of
the marker that’s at the end of the song, because
there’s another marker much earlier in the song.
Try it!  

6. Now that you’ve successfully selected just the
desired area of the song, you may want to bring it
all into view, as much of the selected area may be
off-screen.  Select Fit Selection (-Shift-]) from
the Action menu.  Now the entire selection (ie: the
entire song) will snap into view.

7. To make a region around this selection, just choose
New Region (-Shift-R) from the Action men.  It’s
a good idea to name your regions, as it makes
keeping track of them later in the process much
easier.  Type in a name, and click the OK button.
Don’t forget to save your work!  Song 1 is now

ready, let’s move on to Song 2, which has other
issues...

Fading in & Fading Out:

1. We’ll press -T to tile all the windows again, and
locate our second song – Song 2.  This song also
came out of the DAW just fine, except for the levels
come in a bit too fast in the beginning of the song,
and end a bit too abruptly.  A basic fade-in and fade-
out should really help this song to blend in better
with the songs on the CD that come before and
after it.

2. In this instance, since Song 1 has a nice, smooth
fade-out at its end, we’d like to have Song 2 also
have a smooth fade-in at its beginning, so the two
blend together nicely on the finished CD.  To
accomplish this, you simply need to decide how
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long of a fade-in you would like – in this case, a
short three second fade-in should work well.
Rather than selecting the first three seconds of the
song though, we’ll precisely place a marker at the
three second mark using Peak’s Go To Time com-
mand.  From the Action menu, choose Go
To>Time... (-G)  

When the dialog appears, type in a value of three
seconds, and click OK.  Peak’s playhead cursor
jumps to the three second point in the waveform
automatically.

3. Now that the cursor is in the right place, create a
marker here by typing -M, or by choosing New
Marker from the Action menu.

4. -click in the area between the beginning of the
file, and marker that was placed at the three second
mark to select exactly the first three seconds.

5. With a selection made, you can now fade in just
this portion of the waveform – click the Fade In
button in the Toolbar (or choose Fade In from the
DSP menu).

This technique uses the default fade-in curve – to
customize the type of fade being applied, just
choose a different fade in preset or create your
own, under Peak’s  Preferences panel>Fade In
Envelope.
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DSP Processing Tools:

1. Song number 3 doesn’t have the same issues as the
first two songs – it’s perfectly trimmed and has
nice fades and either end, and sounds good over-
all, but compared to the other two, it just doesn’t
seem as loud.  If used for our CD as is, the listener
would inevitably have to adjust the volume on their
stereo system to really be able to hear this track,
and then might have to turn it down again for the
song that follows.  We can use one of Peak’s DSP
tools such as Normalize to fix this track.

2. To Normalize this song – to get it as loud as possi-
ble, like the first two songs, first open Song 3 in
Peak.  Just about all DSP operation in Peak, with the
exception of sample rate conversion, are based on
a selection made in the audio waveform.  Assuming
we want to normalize the entire song, the easiest
thing to do is to use the Select All command from
the Edit menu, or -A.

3. Now, choose the Normalize command from the
DSP menu –  for this example, leave the amount of
normalization at 100%.  

Peak normalizes the file to the level specified in the
Normalize dialog.  Compare the before and after
levels in the pictures below:

4. Song 3 now has just as much “punch” to it as the
first two songs, and as far as levels go, will fit right
in with the other songs on our CD.

Effects Plug-Ins:

Our next song – Song 4, suffers from yet other problems,
and while it’s fine as far as trimming, fades, and levels are
concerned, something about it just doesn’t sound
“right”.  There’s no low end in this song, so the bass and
kick drums get lost amid the guitar and vocals.  We can
fix this right up though, using Audio Unit or VST format
equalizer plug-ins, both of which are accessible in Peak.
Peak includes the BIAS Freq 4 band paragraphic equaliz-
er – and any of the Audio Units EQs that are included
with Mac OS X can be used as well.  Aside from using
equalization to balance out the missing low frequencies,
we also want to add a little compression to help give this
track a bit more “punch” overall.  Effects plug-ins can be
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used one at a time, with a single plug-in on each of Peak’s
five effects inserts, but when mastering using multiple
plug-ins, the built-in Vbox SE effects routing interface is
handy, as it gives access to many controls all within a sin-
gle interface.

1. With Song 4 open in Peak, we’ll choose Vbox from
the Plug-Ins menu – the Vbox routing interface
appears.  

When using multiple plug-ins, Vbox allows you to
route an audio signal through effects in the Vbox
matrix, in series, in parallel, and also in various
combinations.  Single effects may be soloed,
muted, or bypassed, and A/B comparisons can be
used to compare settings.  In addition to these
routing options, Vbox presets may also be saved.
For example, say you have your five favorite plug-
ins that you always use for mastering, and in each
of these plug-ins, you have specific presets you like
to use.  If a Vbox preset is saved, it includes not
only the position of the plug-in within the Vbox
matrix, but also contains information about each
plug-in’s own presets/settings.  With Vbox, you can
instantly load up your favorite effects, with specific
settings, with just a single click in Vbox’s Presets
menu.

2. Click into one of the empty gray boxes within the
Vbox matrix – in the middle of the interface.  A
pop-up menu appears, with a list of all available
VST plug-ins.  Choose the BIAS Freq 4 EQ plug-in.  

A thumbnail icon of the plug-in now appears in the
Vbox matrix – the plug-in’s name appears at the
top of each box.

3. Now, click in the box just to the right of the box
containing the Freq EQ, and Select BIAS Sqweez,
which is a brand-new compressor/limiter plug-in,
also included with Peak 4.  
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Think of the audio signal flow through the Vbox
matrix as going from left to right.  Audio signals are
fed in from the left, and with the current arrange-
ment of effects, they flow first through the Freq EQ,
and are modified by any settings made in Freq.  Then
the signal flows out of the Freq EQ, and into the
Sqweez comp/limiter, where it’s again modified by
any settings made in this plug-in.  As there are only
two plug-ins in the current arrangement, audio then
flows out to Vbox’s output, and can then be heard
with all of the settings made in the plug-ins.

4. Let’s take a look at some of the features that make
Vbox such a good tool for mastering -

• Solo/Bypass/Mute/Edit - Each plug-in’s  thumbnail icon
has four buttons down its center – S for Solo, B for
Bypass, M for Mute, and E for Edit.  When plug-ins
are arranged in a series, that is – horizontally in the
same row, clicking the Solo button will automatical-
ly bypass the other effects in that same row/series.  

Clicking the Bypass button in any effect in a series
or parallel arrangement simply lets audio pass
through that plug-in, without processing the sig-
nal.

Clicking the Mute button stops audio from passing
through an effect altogether – for example, if there
are two plug-ins, arranged in a parallel (that is, in
separate rows) and one is muted, then audio
would stop flowing through the effect that is
muted, and the only audio that would be heard
would be that going through the un-muted effect.
Likewise, if only one effect plug-in is active in the
Vbox matrix, and it is muted, there would be no
audio output at all.

Clicking the Edit button opens the plug-in’s editor,
or graphical interface, where you can adjust any of
its parameters (knobs, sliders, buttons, etc.)
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• Independent Input/Output Levels - for each plug-in, as
well as for the entire collection of plug-ins within
the Vbox matrix make is easy to get just the right
level for either an individual plug-in, or the entire
collection of plug-ins that are active within the
matrix.

• A/B Comparisons - can be used to create snapshots of
two different states of the Vbox matrix – any set-
tings to plug-in parameters, levels, or arrangement
of plug-ins within the matrix are stored in A/B com-
parison snapshots.  These are useful when compar-
ing two different plug-in setups, such as setting
snapshot A to represent the original state of an
audio file, and snapshot B to represent what the
audio will sound like after plug-in settings are
changed.  The pictures below illustrate how this
works – assume that you have an arrangement of
plug-ins, such as the one illustrated below, that has

two effects in a serial arrangement.  This setup is
sounding pretty good, and we may want to use it,
but we also want to experiment with the same two
plug-ins in a parallel arrangement.  

To temporarily memorize this arrangement of plug-
ins and any setting made in each plug-in’s own
interface, click the Assign State A button at the top
of the Vbox interface...

Now, we’re going to jump out of order for a
moment, to show another of Vbox’s powerful fea-
tures, but we’ll come back to snapshots, so keep
these last couple of steps in mind.

• Real-time, hot-swappable effects - The plug-in thumbnail
icons in Vbox can be moved from any box to any
other empty box, or, plug-ins in an active box can also
be hot-swapped by selecting a different effect plug-in
from the effect assignment pop-up menu at the top
of an active plug-in’s box.  For example, in the last
step, we had two effects plug-ins arranged in a series,
and we assigned these as a snapshot.  Now, we want
to experiment with some different settings, to get
just the right sound.  The picture below illustrates
hot-swapping the BIAS Sqweez comp/limiter plug-in
with BIAS SoundSoap, another plug-in that’s
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installed in our system:

Another option for changing the way the audio sig-
nal is processed is to simply drag a plug-in’s thumb-
nail icon to a different box – the example below
shows how this is done – just grab a part of the
plug-in’s thumbnail (a part that has no controls on
it!) and drag it to an empty box.  A grey outline indi-
cates where the plug-in will be dropped when the
mouse button is released.  

The next couple of pictures show moving the plug-
in into a new box, finally ending up with a parallel
arrangement of these two effect plug-ins.

By moving Sqweez to this new location, what has
happened is that rather than having a serial plug-in
arrangement, where the audio flows from one
effect into the next, the signal now flows into both
effects simultaneously, is processed simultaneously
in each effect, and then the split signal rejoins and
moves to Vbox’s outputs.

Now, back to A/B Comparisons...

So, we had saved one arrangement of plug-ins in a
series as Snapshot A, which looked like this:

Let’s now set the new parallel arrangement as
Snapshot B, and show how to jump back and forth
between the two setups.  With the desired effects
in the desired boxes, simply click the Assign State
B button at the top of the Vbox interface.
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With both A & B snapshots set, you can instantly
recall a state by clicking either the State A or State
B buttons, also at the top of the Vbox interface.  

This feature is invaluable for quickly going back
and forth between two settings.

• Master Wet/Dry slider - Vbox also offers a master
Wet/Dry slider, to control the overall amout of
effect being applied to an audio signal.

When this slider is in the “Wet” position, the audio
signal being processed through Vbox is receiving
100% of the effects, and when in the “Dry” posi-
tion, the audio is receiving 0% of the effects.  In any
other position between Wet and Dry, the signal is
receiving some percentage of the effects.

Back to Song 4... - This side trip into the inner working of
Vbox should help us with the original goal – to give
Song 4 in our mastering project a bit more low-end
presence and compression, so that it fits in with
the other songs on this CD...  Our last step dis-
cussed some of the benefits of using Vbox for mas-
tering, but let’s get back on track, and finish up this
last song, and burn a CD!

5. With BIAS Freq & Sqweez assigned in Vbox in a
series arrangement, click the Edit button in each
plug-in’s thumbnail icon.
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When the Freq EQ interface comes up, look for
parametric filter band 2...

Here, we lowered the Q (bandwidth) value, so this
band affects a wide frequency range...

We then boosted mainly the low frequencies using
the numbered filter band indicators in Freq’s
graphical frequency display.  Since we boosted
some levels, we’ll also lower the overall output
level to avoid clipping – using the output level slid-
er....

In the Sqweez comp/limiter interface, we’ll adjust
the threshold, attack, release, ratio, and knee con-
trols to the desired settings.  (For more informa-
tion on Sqweez’s controls, please consult the
Sqweez Read Me file that was installed along with
Peak 4).

6. To apply the plug-in settings to Song 4, choose
“Bounce” from the Plug-Ins menu.  

DSP Effects Tools:

Some of Peak’s most powerful audio processing tools are
found under the DSP menu – there are exotic functions,
such as Convolve, Change Duration, Reverse
Boomerang, Rappify, Modulate, Harmonic Rotate, and
ImpulseVerb – as well as more common but still useful
functions, like Fade In/Out, Add, and Mix – many of
Peak’s DSP tools can be invaluable in a mastering session.
During the mastering process, you may wish to use
native DSP tools to vary levels, panning, or perhaps add
a touch of reverb – to create the desired effects.

As an example of how Peak’s DSP tools might be used to
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enhance an audio file for just the right effect, let’s look at
ImpulseVerb.  ImpulseVerb is a sample-based reverb tool,
which operates using Peak’s already powerful
Convolution algorithm.  Convolution is a unique and
powerful sound design tool that slows you to apply the
sonic (i.e., spectral) characteristics of one sound onto
another.  Convolution works by multiplying the frequen-
cy spectrum of the impulse contained in the clipboard
and that of the target audio document, reinforcing the
frequencies that are in common between the two.  The
results are always interesting and often quite unlike any-
thing you’ve heard before.  This is especially true when
the character of the two sounds is very different, and
when the clipboard impulse is harmonically rich (imag-
ine for example, convolving a rainfall sample with piano
tinkling!).

ImpulseVerb was specifically created to allow the convolu-
tion of Impulse-Response files with music, dialogue, etc. to
create a very rich and natural sounding reverb.  Impulse-
Response (IR) files are essentially recordings of an environ-
ment that can be applied to other files, giving the impres-
sion that those files were also recorded in the same envi-
ronment.  IR files are typically created by setting up a mic
(or a number of mics) in the desired environment, and
recording a sound with a strong impulse to it – usually a
balloon pop – and the reverberation and decay of this
sound.  The larger the environment (think cathedral) the
longer the reverberation lasts, and when applied to anoth-
er audio document, the effect is that of a very rich reverb.

Peak includes hundreds of IR files, everything from com-
puter-modeled spaces with various types of textures, such
as wood paneling or carpet, to real recordings of famous
cathedrals and performance halls.  In addition, users may
also download IR files from the web and add them to the
library of files, or they can record and add their own IR files.

To get an idea of how this technology works, let’s take a
look at some files.

1. Navigate to the directory where Peak’s Impulse-
Response files are stored:
MacHD/Library/ApplicationSupport/BIAS/Peak/PeakImpulses/GrandSpaces/

2. Open the file called “domkyrkan1 - WWSS.aiff ”

Before going any further - turn down the volume
of your speakers or headphones.  Impulse
Response files start at their loudest volume and
fade away quickly - having the volume turned up
too high can damage your hearing and equip-
ment.

3. With the volume on your playback system turned
down most of the way, press the spacebar to play the
IR file.  This file was created by recording a balloon
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pop in a large cathedral.  If your system’s volume was
too low to hear this well, turn it up a bit and audition
the file again.  It’s easy to hear the reverberation qual-
ities in an IR file, and this reverb effect can be applied
to any other audio file.

4. Now, open another file - one of the songs from your
current mastering session.  Peak offers real-time pre-
view of the ImpulseVerb DSP feature, and this is
based on a selected protion of the audio waveform.
Make a selection (loops work great) and then from
Peak’s DSP menu, choose ImpulseVerb.  

When the ImpulseVerb interface appears, choose
the same IR file as you just listened to, from the
Space pop-up menu - “domkyrkan1 - WWSS.aiff ” -
this file is in the Grand Spaces category.

Move the Wet/Dry slider all the way to the Dry posi-
tion (0% of effect applied), and click the Preview but-
ton.  The area you selected in the audio waveform
will now begin to play.  Slowly move the Wet/Dry slid-
er toward Wet, and you’ll slowly hear more and more
reverb applied to the target audio document.  To
apply a setting you like, just click the Apply button -
to preview a different area, click the Cancel button,
and select a different area of the waveform, and open
ImpulseVerb again.

5. If you like most of the qualities of one of the IR files,
but would like to modify it slightly, you can do so by
modifying the Space Envelope.  The Space Envelope
is an envelope that controls the length and decay of
the reverb.  By default it looks like this:

To shorten the reverberation time of a given IR file,
you may want to change the settings to something
similar to those below:
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That’s an example of one of Peak’s native DSP tools in
action.  

Removing Hiss, Hum, & Rumble
with SoundSoap:

The next stage of our mastering exercise will be remov-
ing unwanted broadband noise with a dedicated noise
reduction plug-in.  This step will get rid of any low level
line noise and give a little extra polish to our songs.  In
this case, we’ll look at the BIAS SoundSoap plug-in –
which will be “plugged-in” into Peak, thereby adding
broadband noise reduction processing to Peak.

SoundSoap is designed specifically to reduce/remove
“broadband” noise.  Broadband noise includes analog
tape hiss, 50 & 60 Hz hum, low-frequency rumble, DV
camera motor noise, air-conditioning system noise, and
many other types of noise that have a pattern to them.  

SoundSoap is not designed to work with clicks and pops,
as might be encountered when recording old vinyl LPs.
For information about removing clicks and pops, please
refer to the section of this workbook called “Removing
Clicks and Pops”.

To remove noise with SoundSoap:

The first step in reducing noise in digital media is to open
the file in Peak, then open SoundSoap.  The following
steps will guide you through your first attempts at noise
reduction.

1.  Launch Peak

2.  Open noisy file

3. Choose “Insert 1>VST>SoundSoap from the
Plug-Ins menu

4.  When the SoundSoap interface appears, enable the
Learn Noise button

5.  Start playback by pressing the space bar, or by click-
ing the Play button in Peak’s transport window

6.  Listen to the results

7.  To apply/render the current noise reduction set-
tings, choose “Bounce...” from Peak’s VST Plug-Ins
menu

Congratulations!  You’ve just learned the basics of using
SoundSoap.  Now, we’ll show some advanced techniques
to fine tune the noise reduction.
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8.  Turn the Noise Reduction knob all the way to the
right for the maximum amount of noise reduction

9.  While listening to your media, adjust the Noise
Tuner knob to fine-tune if necessary (see tip
below)

10. While still listening to your media, (in the “On” lis-
tening mode) slowly turn the Noise Reduction
knob to the left to reduce the amount of noise
being  taken out.  Continue to reduce the Noise
Reduction setting until you reach an acceptable
compromise between the amount of noise being
reduced and any audible artifacts from the noise
reduction process

11.  Now, using the Mode Buttons, toggle between the
“Off ” and “On” listening modes.  This allows you to
compare the “before” and “after” states of your
audio file

12.  To apply/render the noise reduction settings to the
file, go to Peak’s VST Plug-Ins menu, and choose
“Bounce...”

Removing Clicks & Pops:

Clicks and pops are something that everyone working
with digital audio will run into at one time or other.
These unwanted sounds can occur in a variety of ways,
and some common ways they occur are when recording
old vinyl LPs, or cutting audio at non-zero crossings of
the waveform.

Regardless of how they occur, they’re usually unwanted
artifacts, and Peak offers an easy and effective way to
remove them.  Peak’s Pencil Tool works by “re-drawing”
the samples that make up the click or pop, essentially re-

assigning the values those samples.  By smoothing out
the very abrupt amplitude transition, the unwanted
sound is eliminated.

The following steps show how to use the Pencil Tool to
repair a click.

To repair a click:

1.  Open an audio file in Peak that contains a click or
pop.

2.  Audition the file in Peak to locate the click.

3. When you have located the click, place the mouse-
cursor directly over the click, and click into the
waveform, so Peak’s playhead indicator is directly
over the click (or as close as possible).
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A click in an audio waveform – when zoomed in to sample level



5.  Using the Zoom In command, zoom in on the
audio waveform until you can clearly see the click.

6.   From Peak’s Cursor Palette, select the Pencil Tool.

7.  Draw across the the area in the waveform where
the click occurs, trying to approximate the shape of
the waveform on either side.

8.  Zoom out and audition the section of audio that
had a click - it should now be gone.

Peak 4 adds a “Magic Pencil Tool” mode that
allows a selected/highlighted click to be automati-
cally repaired – With a click selected in the audio
waveform, simply select the Pencil Tool, hold down
the Option key, and click the mouse button direct-
ly over the click (the audio click that is) in the
waveform – Peak automatically repairs the click!

Sample Rate/Bit Depth/File
Format Conversions

To master an audio CD in Peak from multiple audio doc-
uments, you’ll be drawing audio regions from several dif-
ferent source files into a single Peak Playlist document.
In order to successfully create this compilation, the bit
depths and sample rates of the documents must be the
same - that is, you cannot mix files with different bit
depths and sample rates in a single Playlist.

To achieve a consistent bit depth and sample rate, Peak
includes two very necessary processes - sample rate con-
version and dithering.  

Sample rate conversion allows files recorded at a high
sample rates - such as 96 kHz or 192 kHz - to be reduced
to 44.1 kHz as a final processing step, so that the result-
ing audio CD burned from Peak will be playable in any
standard audio CD player.  Typically, it’s best to leave files
in a high-resolution format for all effects processing and
editing, and to reduce their sampling rate as one of the
last steps before assembling a Playlist and burning an
audio CD master.

Likewise, files recorded at a high bit depth - such as 24 or
32-bit - will need to have their bit-depths reduced to 16
bits before burning a master CD.  Only 16-bit audio files
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The click – selected

Choosing the Pencil Tool

To repair a click, simply draw across its base, trying to approximate
the shape on either side

The click now “drawn out”



can be burned as a standard audio CD, and be recogniz-
able to a standard audio CD player.  The process of
reducing the bit-depth of a file is known as dithering, and
there are various approaches to it.  Rather than simply
truncating (and thus eliminating) the extra bits (and bet-
ter audio fidelity), Peak uses a special dithering algorithm
called POWr™ (Psychoacoustically Optimized
Wordlength Reduction), which is licensed from the POWr
Consortium – an industry leading audio research organ-
ization.  By using this special dithering technology, the
resulting 16-bit files are able to retain a higher perceived
audio fidelity, such as that of a 20-bit file, for example.

File Formats

To create a Peak Playlist, you’ll want to use the highest
quality audio file format available.  Since we’re working
with Peak on the Macintosh, this means working with
either AIFF or Sound Designer II file formats.  These for-
mats are equal in terms of audio quality, and differ only
in the type of additional information that can be stored
in the file’s header.  This additional information may
include various forms of reference markers used in differ-
ent host applications.

AIFF and Sound Designer II (SDII) formats may be mixed
within a Peak Playlist document.  It is however recom-
mended that other file formats first be converted to AIFF
or SDII before assembling a Playlist and burning an audio
CD.

Performing any of the processes mentioned above is a
simple - the step-by-step directions for each follow.

To Convert Sample Rate:

1. Open the desired audio document

2. From Peak’s DSP menu, choose Convert Sample Rate

3. When the Convert Sample Rate dialog appears,
choose 44,100 Hz (or 44.1 kHz) from the Sample
Rate pop-up menu

To dither a file from a high bit-depth to 16-bit format, use
the steps below...

To Dither a High Bit-Depth File & Save As AIFF or SDII
Format:

1. Open the desired audio document – or use the
same document used in the last step (Sample Rate
Conversion)

2. From Peak’s File menu, choose Save As...

3. When the Save dialog appears, select either AIFF or
Sound Designer II from the File Type pop-up menu

4. Choose 16-bits from the Bit-Depth pop-up menu
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Choosing the audio CD standard – 44.1kHz – from Peak’s Convert
Sample Rate dialog



5. Enable POWr dithering by checking the POWr
dithering checkbox

6. Click the Save button

That’s all there is to it - your audio files are now ready to
be compiled into a Peak Playlist document.

Building Playlists & Burning
Audio CDs:

Now that all of our songs have been spruced up, and are all
in perfect shape, it’s time to assemble these in a Peak Playlist
document in the desired order, add just the right gap times
between songs, and perhaps crossfade some songs together,
and add subtle gain changes.  VST effects, plug-ins, and Vbox
may also be used in the Playlist on a per region basis, with
dedicated effects “snapshots” being applied individually to
each region.  Playlists essentially serve as a “blueprint” of a
finished audio CD - the Playlist window contains Play, Stop,
Next Track, and Previous Track controls, just like those found
on a CD player.  The CD you burn from Peak’s Playlist will
sound identical to the regions arranged in a Playlist.

1. The first step in building a Playlist is to open all the
audio files you wish to use in it, so we’ll open Songs 1-
4.  It’s also handy to be able to quickly view/access any
of the files, so you may want to tile the windows (-
T).

2. Next, create a new, empty Playlist by selecting
New>Playlist Document from the File menu.  The
Peak Playlist window appears...

3. Now, the idea is to add items to the Playlist - but what
items can be added, and where do they come from?
The only items that can be placed into a Playlist are
audio regions.  Regions are sections of audio docu-
ments that have been defined by Region Markers - one
marker defines the beginning of a region, while anoth-
er defines the end.  A region can be as long as an entire
audio document, or as short as a single sample.  An
easy way to create a region is to make a selection with-
in the audio waveform, and then select New Region
from the Action menu.  This technique inserts a region
begin marker at the beginning of the selection, and a
region end marker at the end of the selection.  At any
point after the region markers are added to the file,
the length of the region may be modified by either
dragging the triangular base of a region marker to the
left or right, or by double-clicking the triangular base,
which brings up the Edit Region dialog.  In this dialog,
you can type in desired values for beginning, end, or
overall length of the region.  (Marker times may also
be modified by typing into the text fields of the File
Drawer or Contents Palette.

When creating regions in several audio documents, as
we’re doing in this example, it doesn’t matter which
are created first.  At this stage we’re not concerned
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Creating a new Playlist document

An empty Playlist



with the order of songs - that’s something that will be
determined in the Playlist.  In the previous steps
where we edited each of our four songs, Song 1 had a
region created in it, so let’s examine it first.  Click the
Toggle File Drawer button in the upper right corner of
Song 1’s document window.  

Click the disclosure triangle next to the audio doc-
ument’s name in the File Drawer...

A list of any regions in that document is revealed.  

(Clicking the Region, Reference, or Loop Marker
buttons changes what’s displayed in this list).

This is one way to access the regions that we can
add to our currently empty Playlist.  This method
shows only the regions contained in a single audio
document.  In other cases, you may wish to see all
the regions contained in all the open audio docu-
ments - Peak also allows this, just choose Contents
from the Windows menu, and the Contents Palette
appears...
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Opening an audio document’s File Drawer...

Each document’s File Drawer contains a library of reference, region,
and loop markers specific to that document

Clicking the disclosure triangle to reveal a list of regions

“Song1” showing the one region it contains – also called “Song1”

The buttons at the bottom of the File Drawer allow you to see either
reference, region, or loop markers

The Contents Palette is a global library of reference, region, and loop
markers



The Contents Palette is a global library of region,
reference, and loop markers contained in any open
audio documents in Peak.  Initially, you’ll see each
open audio document’s name with a disclosure tri-
angle just to the left of the name.  Clicking these
triangles reveals a list of any region, reference, or
loop markers in any of the open audio documents.
So, to get back to the practical stuff, click on the
name of the region in Song 1’s File Drawer (be sure
you’re clicking the name of the region, rather than
the name of the document itself!) and drag it into
the Playlist window.  

When you release the mouse button, you’ll see that
there is now one item in the Playlist.

4. For the other three songs, let’s drag their regions
from the Contents Palette into the Playlist.  If the
Contents Palette isn’t still open, just choose it from
the Window menu, and click the disclosure trian-
gles next to each song name to access each song’s

regions.  In the same manner as with the File
Drawer, just click on a region’s name, and drag it
into the Playlist.  Now we’ve got a full Playlist with
our four songs in it - if we were to burn a CD at this
point, it would contain four individual tracks.  Each
region in a Playlist translates to a single CD track.

5. Do we really want to arrange these songs in order
from 1 to 4?  Perhaps we really want to have Song 4
appear first, with Song 2 second, Song 3 third, and
Song 1 last.  Once regions are in a Playlist, they can
be re-ordered by clicking on the region’s name (or
anywhere in the region’s row) and dragging up or
down.  A thin, horizontal green line appears, indi-
cating the new position of the region when the
mouse button is released.  

We’ll move the regions around so that by region
name, they appear in this order:  4, 2, 3, 1...

6. We have the songs in the correct order now, but
what else can be done in the Playlist?  We can also
designate the gap time between tracks, or control
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Dragging a region from the Contents Palette into the Playlist

One region, or “Playlist Event” now added to Playlist

Note position of insertion point – represented by a thin, green, hori-
zontal line.  When the mouse button is released, this line indicates the
new position for that Playlist Event/Region

Our finished Playlist – with songs in the desired order



how two songs are crossfaded and blended into
one another.  Let’s add a standard two second gap
between the first, second, and third songs, but
then we’ll crossfade the third song into the last
song, so that they blend together seamlessly.  To
create the two second gaps for the frist few songs,
just double-click in the region’s row, under the Gap
Time column...

When the Playlist Event Gap Time dialog appears,
type in 2, for a two second gap time...

7. To blend the end of Song 3 into the beginning of
Song 1, we must create a crossfade between the
two, another process that’s always performed in
the Playlist window.  There are two ways to create
crossfades - the first is by simply double-clicking in
the “Sec” (Seconds) column and typing in the
desired length of the fade in seconds.  Keep in
mind that each region’s row has two “Sec”
columns, one for fading in and the other for fading
out.  To use this technique to crossfade Songs 3
and 1 together, we would need to assign a fade out

value for Song 3, and the fade in time for Song 1.  If
we wanted to have a simple 5 second crossfade
between the two regions, we’d just type in a 5 sec-
ond fade out time for Song 3, and a 5 second fade
in for Song 1.  Since the fade in and fade out hap-
pen simultaneously, the effect is that the two songs
blend together.  Look at the diagram below for
more detail...

8. Sometimes it’s not possible or practical to simply
enter these fade times without a visual reference to
the audio material.  In these cases, you’ll want to
use the Playlist’s Nudge Regions window, which is
a visual region crossfade editor.  This window
allows you to visually see where in the audio wave-
form the fades will occur, and compare the fade in
portion of one region to the fade out of the next
region.  When using the Nudge Regions window,
it’s important to always select the region in the
Playlist that you’ll be fading into, and then going
into the Nudge Regions window.  Since we’ll be
fading into Song 1, our last song, we’ll first select
Song 1 in the Playlist, and then click the Nudge
Regions button in the upper left of the Playlist to
open the graphical editor.  
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Double-clicking a Playlist Event under the Gap Time column lets you
type in a custom gap time duration

The Playlist Event Gap Time dialog

Typing a Fade-Out value of 5 seconds directly in the Playlist...

And a Fade-In value of 5 seconds

Clicking the Nudge Regions button



The Nudge Regions window appears...

9. Notice that the Nudge Regions window opens with
fade-in & fade-out envelopes already in place - the
reason for this is because we had already typed in
a value of 5 seconds directly in the Playlist for how
long these fades should be.  Essentially, you can
either type a crossfade value right into the Playlist,
or you can open the Nudge Regions window and
click in the audio waveform and drag the fade
envelope to the desired length.

Both techniques will give the same length of fades,
but the Nudge Regions window is handy for cases
that need a visual representation of the audio
regions being crossfaded together.  We can now
click on the existing 5 second fade envelopes and
drag them with the mouse to a different length.
The controls at the bottom of the Nudge Regions
window allow us to audition the transition between
the two regions, to see if the crossfade will work.
Pre-roll & post-roll values may be entered to give a
bit of extra audio preceding and following the
crossfade, which also helps to put the transition in
the context of the audio that comes before and
after it.  To hear the crossfade, click the Play button,
and to stop playback, click the Stop button (Play
button changes to a Stop button once playback is
engaged).
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Crossfade Diagram

First Region

Next Region
Next Region’s Crossfade In

First Region’s Crossfade OutEnd of first region, beginning
of second region, and exact
mid-point of crossfade

The “Nudge Regions” window is a graphical region crossfade editor

Entering a 5 second Fade-Out value in the Playlist...

Is the equivalent of dragging the Fade-Out envelope in the Nudge
Regions window to a length of 5 seconds...

And entering a 5 second Fade-In value for the next region...

Is the equivalent of creating a 5 second Fade-In envelope in the
Nudge Regions window



It is very important to understand that the Region

marker in the reference audio document is the
exact midpoint of the fade.  Consequently, there
must be sufficient audio data on either side of the
Region marker.  That is, if you have a 60 second
crossfade between two Playlist Events (regions),
there must be at least 30 seconds of audio data fol-
lowing the end region marker of the first playlist
event (region), and there must be at least 30 sec-
onds of audio data preceding the begin region
marker of the second playlist event (region).

For our purposes, the original 5 second crossfade should
work fine - let’s move on.

10. Let’s add a slight gain reduction to Song 3 - also the
third item in our Playlist.  To adjust the gain, simply
double-click in Song 3’s row, under the Gain col-
umn, the Playlist Event Gain dialog appears, and
allows you to specify the gain in Decibels.

11. Our completed Playlist arrangement is now fin-
ished, and ready to burn to a Red Book master CD.
We’ll check that the Playlist is the front-most docu-
ment in Peak, and choose Select All from the Edit
menu to indicate the items you wish to be burned
to CD.

12. Click the Burn Audio CD button in the upper left
corner of the Playlist window...

The Burn Audio CD dialog in Peak gives you various
options - choosing from multiple burners that may be
connected to your Macintosh, using POWr dithering (if
burning from 24 or 32 bit files), verifying the CD after
burning, and burning in Simulation Mode.  Select the
desired options, and click Burn.
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Select all the items in a Playlist to burn them all to CD

Double-clicking a Playlist Event under the Gain column allows you to
non-descructively specify a new Gain value

The Playlist Event Gain dialog

After a -5dB gain change

Click the Burn button when your Playlist is as you like it



13. Peak prompts you to insert a blank CD...

14. You can monitor burn progress in Peak’s Transport
window...

15. In just a few minutes, your CD in finished!
Congratulations!  You’ve just learned all that’s
required to master and burn an audio CD direct
from Peak!

Exporting a Playlist for use in
Roxio Jam

In addition to burning audio CDs directly, Peak can also
export a completed Playlist as a Jam Image file, for use in
Roxio’s Jam CD mastering software.  Jam Image files
exported from Peak can be opened in Jam, and at any
point while working in Jam, these files can be opened
back up in Peak for editing.  Like many other audio and
video applications, Jam allows Peak to be assigned as a
dedicated exteranal audio editor.  To export a Peak
Playlist in Jam Image file format, follows these steps:

1. Buiild a Peak Playlist

2. Select all in the Playlist

3. Click the Bounce Playlist button, in the upper left
corner of the Playlist window.

4. In the Bounce Playlist dialog, select Jam Image
from the File Format pop-up menu, and click the
Bounce button.
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The Burn Audio CD dialog gives various burning options

Peak will prompt you for blank media

Monitoring burn progress in the Transport window

Your hit album master is ready!

Select All in a Playlist to bounce all Events/Regions to a new file 

Clicking the the Bounce Playlist button



5. A Save dialog appears - enter a name for your file,
and click Save.

6. Your Jam Image file is saved and ready to open in
Roxio Jam.

That’s all there is to mastering a CD in Peak!
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Choose JAM Image File from the File Format menu

Choose a name and location for the JAM Image file

A JAM Image file, with all info from the Peak Playlist – ready to open
in JAM


